
Stata Kullanımı (Stata 14)
Arş. Gör. Selçuk GEMİCİOĞLU

Eylül 2019

İçindekiler

1 Giriş 2

2 Stata Nedir? 2

3 Niçin Stata? 2

4 Stata Arayüzünün Tanıtımı 3

5 Çalışma Klasörü Tanımlama 4

6 Veri Girişi 5

7 Veri’nin İncelenmesi 10

8 Veri’nin Kaydedilmesi 12

9 Veri Setine Ait Tanımlayıcı İstatistikler 15

10 Veri Seti ve Değişkenler ile Yapılan Temel İşlemler 18

11 Grafik Çizme 26

12 Do ve Log Dosyaları 29

13 Yardım 32

14 Kaynaklar 34



Selçuk GEMİCİOĞLU AÜSBF

1 Giriş

Ekonometri teori ve uygulamanın iç içe olduğu bir alandır. Uygulamasız bir ekonometri dersi yakıtsız bir
araba gibidir. Bunun içindir ki birçok araştırmacı teorik bilgilerin gerçerliliğinin gerçek veriler kullanılarak
test edilmesine oldukça önem vermektedir. Bu doğrultuda dersin amacı teorik bilgilerinizin uygulamayla nasıl
entegre edileceğini öğretmektir1.

Ekonometrik analizler Stata programı kullanılarak yapılacaktır. Ekonometrik analizlere geçmeden önce Sta-
ta’nın kullanımı ile ilgili temel bilgiler sizlere verilecektir. Bu bilgiler analiz yeteneğinizi artırmanın yanı sıra
ilerde karşınıza çıkacak olası ödev, tez, proje vb. çalışmalarda da işinizi oldukça kolaylaştıracaktır. Stata
kullanım becerisini daha fazla geliştirmek isteyenler yalnızca derste anlatılanlarla kendilerini sınırlamamalı,
önerilecek olan ek kaynaklarla çalışmaya devam etmelidirler.

2 Stata Nedir?

StataCorp’a (2016) göre Stata veri analizi, veri yönetimi ve grafikler için ihtiyacınız olan her şeyi sağlayan
eksiksiz ve entegre bir istatistiksel yazılım paketidir. Temel olarak Stata, verileri (büyük ve küçük veri setle-
rini) saklamanıza ve yönetmenize, verileriniz üzerinde istatistiksel analizler yapmanıza ve anlaşılır görselliğe
sahip grafikler oluşturmanıza olanak sağlayan bir yazılımdır.

3 Niçin Stata?

Ekonometrik analizleri gerçekleştirmek için Stata kullanan çok sayıda araştırmacı vardır. Fakat diğer istatis-
tik programlarını (SPSS, SAS, Eviews, R, Matlab ve Gauss) kullanan pek çok insan olduğu da bilinmektedir.
Bu durumda aklınıza gelen ilk soru neden Stata’yı tercih ediyoruz olacaktır.

Stata’yı tercih etmemizin başlıca nedenleri arasında büyük veri setlerinin (örneğin milyonlarca gözlem) kul-
lanımına ve düzenlenmesine izin vermesi ve panel ve zaman serisi regresyon analizleri için sürekli gelişme
göstermesidir. Ayrıca Stata belirli bir ihtiyacı olan kullanıcılar tarafından sürekli olarak güncellenmekte veya
geliştirilmektedir. Bu güncellemeler kendi yazılımınızla kolayca entegre edilebilmektedir.

1Bu ders notu SBF Maliye Bölümü son sınıf öğrencileri için hazırlanmıştır. Ders notunda yer alan tüm hata ve yanlışların
sorumluluğu bana aittir. Sorularınız ve değerli görüşleriniz için email adresi <sgemicioglu@ankara.edu.tr>. Görüşmeler için
adres, SBF Fazıl Kafadar Spor Salonu 2. kat 145 nolu oda.
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4 Stata Arayüzünün Tanıtımı

Bilgisayarınızda Stata’yı (Stata 14 sürümü için) açtığınızda varsayılan ekran görüntüsü aşağıdaki gibidir.

Stata’nın arayüzünde 1- Sonuç Penceresi, 2- Komut Penceresi, 3- Değişkenler Penceresi, 4- Geçmiş İşlemler
Penceresi ve 5- Özellikler Penceresi yer almaktadır.
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1- Sonuç Penceresi

Stata’ya yazdığınız komutların sonucunu gösterir. Yeni bir dosya açtığınızda bile, bu pencerede bir “sonuç”
görülmektedir. Sonuç penceresi, özellikle bir komutun çalışıp çalışmadığını anlamak için kullanışlıdır. Ör-
neğin, Stata’ya yeni bir değişken oluşturması komutunu verirseniz, sonuç penceresi size yeni bir değişken
oluşturup oluşturmadığınızı söyleyecektir.

2- Komut Penceresi

Stata’ya verilerinizle ne yapmak istediğinizi anlatmak için komutları (Stata’nın tanıdığı ve belirli bir işlevle
ilişkilendirdiği kelimeler) girdiğiniz alandır.

3- Değişkenler Penceresi

Stata’ya aktarılan veri setindeki değişken isimlerinin ve açıklamalarının yer aldığı alandır.

4- Geçmiş İşlemler Penceresi

Stata’da çalışan ve çalışmayan tüm komutların kaydının tutulduğu yerdir. Bu alan, yazdığınız tüm komutları
izlemenize yardımcı olur. Bunun yanı sıra komutları bu pencereye kopyalayıp yapıştırabilir ve bu pencerede
yeniden çalıştırabilirsiniz.

5- Özellikler Penceresi

Stata’ya aktarılan veri setinde yer alan değişkenlerin ve veri setinin özelliklerini görüntüler. Özellikler pen-
ceresini kullanarak değişken ve veri seti özelliklerini değiştirebilirsiniz.

5 Çalışma Klasörü Tanımlama

Açık bir Stata dosyasıyla herhangi bir işlem yapmadan önce, daima çalışma klasörünüzün konumunu ta-
nımlamanız gerekir. “Çalışma klasörü”, belirli bir proje veya analiz için tüm verilerinizi sakladığınız ve
bilgisayarınızın herhangi bir sürücüsünde yer alan bir klasördür.

Birden fazla veri seti ile çalışılması, dosyaların başka dosyalarla karışması ya da çalışılan dosyaların ayrı
klasörlerde yer alması oldukça kafa karıştırıcı bir durumdur. Bu yüzden tüm veri setlerinin ve dosyaların
içerildiği çalışma klasörünün oluşturulması ve tanımlanması bu kafa karıştırıcı durumları ortadan kaldıra-
caktır.

Bunu yapmak için öncelikle bilgisayarınızın “D” sürücüsünde Stata_workshop adında boş bir klasör
oluşturunuz ve ardından Stata’yı açınız. Stata’da çalışma klasörünün yerini tanımlamak için aşağıdaki kodu
komut penceresine yazıp enter’a basınız.

Not: Burada çalışma dosyası “D” sürücüsünde tanımlanmıştır. Fakat bilgisayarınızın hangi sürücüsünde
çalışacağınız tamamen size kalmıştır isterseniz “C” veya başka bir sürücüde de çalışabilirsiniz. Ayrıca klasör
ve dosya isimlerinde Türkçe karakter ve boşluk bulunmamasına dikkat ediniz.

. cd "D:\Stata_workshop" /* Çalışma klasörünüzü tanımlar */

Çalışma klasörünün yerininin doğru tanımlanıp tanımlanmadığını kontrol etmek için aşağıdaki kodu komut
penceresine yazınız ve enter’a basınız.

. pwd /* Şu anki çalışma alanınızı gösterir */

Not: Yukarıdaki kodlarda görüleceği üzere kodların başında “.” vardır. “.”, kodların parçası olmadığı için
kodları yazarken “.”’yı kullanmayınız. Ayrıca yukarıdaki gibi bazı kodların yanında yorumlara /* YORUM
*/ yer verilmiştir. Yine bu yorumlar kodların bir parçası değildir yalnızca açıklama amaçlı kullanılmıştır.
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Sonuç penceresinde görüleceği üzere “D” sürücüsünde Stata_workshop adlı klasörde çalışmaktasınız. Şu
anki çalışma alanınızı gösteren komut da aynı sonucu vermiştir.

6 Veri Girişi

Bu bölümde veri setinin Stata’ya nasıl girileceği anlatılacaktır. Veri seti Stata menüsü kullanılarak ya da
komut yazılarak Stata’ya aktarılabilir. Stata xls, xlsx, csv, dta, txt ve bazı istatistik programlarının kendi
uzantılı dosyalarında yer alan veri setlerini çekebilmektedir. Burada dikkat edilmesi gereken durum ise farklı
uzantılı dosyaları Stata’da açabilmek için yazılacak kodun farklılaşmasıdır. Bu derste xls, xlsx ve dta uzantılı
dosyalarda yer alan veri setleri kullanılacaktır. Bu yüzden yalnızca bu dosyaların Stata’ya nasıl aktarılacağı
öğretilecektir.

Veri seti Stata formatında yani dta uzantılı bir dosyadaysa, use komutu kullanılarak aşağıdaki kodlar yar-
dımıyla veri seti Stata’ya aktarılır.

. use "D:\Stata_workshop\auto.dta", clear

. use ".\auto.dta", clear

Not: İkinci komutta “D:/Stata_workshop” yerine yalnızca “.” kullanılmıştır. Çünkü “.”, Stata’ya tanım-
ladığınız çalışma klasörü içinde çalıştığınızı söyler.
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Stata menüsünden ise File > Open > D > Stata_workshop > Auto dosyasını seç > Aç adımlarını
izleyerek aynı veri setini açabilirisiniz.
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Veri seti xls uzantılı yani bir excel dosyasındaysa aşağıdaki kod ile Stata’ya aktarabilirsiniz.

. import excel "D:\Stata_workshop\table_7_9.xls", sheet("Table 7_9") firstrow clear

Yine Stata menüsünden File > Import > Excel spreadsheet > Browse > D > Stata_workshop
> table_7_9 adlı dosyayı seç > Aç > Import first row as variable names kutucuğuna tıkla >
Ok adımlarını izleyerek aynı veri setini açabilirsiniz.
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Gerekli adımlar takip edildikten sonra aşağıda görüleceği üzere veri seti Stata’ya aktarılmıştır.

Şimdi Stata programının kurulumu ile birlikte gelen ve farklı ülkelerdeki beklenen yaşam süresi hakkında
bilgiler içeren bir veri setini açıp kullanacağız. Bu veri setine lifeexp.dta adı verilmiştir ve Stata programıyla
aynı yerde saklanmaktadır. Kodunuzda yer alan dosya yoluna ve dosya uzantısına (.dta) yazmaya gerek
yoktur (use komutuyla yaptığınız gibi), çünkü sysuse komutu Stata’ya kendi veri dosyasını kullandığını
söylemektedir.

Not: Stata’nın içindeki diğer veri setlerini görmek için sysuse dir komutunu kullanabilirsiniz.
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. sysuse lifeexp, clear

7 Veri’nin İncelenmesi

Stata’ya aktardığımız veri setine göz atmak isteyebilirsiniz. Bunu, Stata menüsünden Data > Data Editor
> Data Editor (Browse) seçeneğine giderek, menüden gözat sekmesine tıklayarak, browse komutunu ya
da CTRL + 8 kısayolunu kullanarak yapabilirsiniz.

Data > Data Editor > Data Editor (Browse) seçeneği ile;
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Menüden gözat sekmesine tıklayarak;

. browse
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Dört farklı şekilde de veri düzenleyicisi açılır ve aşağıdaki ekran görüntüsüne ulaşılır.

Veri düzenleyicisinde görüleceği üzere her bir sütunda değişkenler ve onların değerleri yer almaktadır.

8 Veri’nin Kaydedilmesi

Ekonometrik bir analiz için veri seti oluşturduğunuzda veya size bir veri seti verildiğinde, bu dosyaları
indirilenler klasörünüzden veya masaüstünüzden kullanmak gerçekten kötü bir uygulamadır. Bu dosyaları
kaydetmeye karar verdikten sonra dosyaların kaydedilmesi için en makul yer çalışma klasörünüzdür. Dos-
yalarınızı çalışma klasörünüze kaydetmek için ya Stata menüsünden faydalanabilir ya da save komutunu
kullanabilirsiniz.

Örneğin Stata içinde yer alan auto.dta veri setini Stata’ya aktarınız (hatırlarsanız bu kısmın nasıl yapıla-
cağını veri girişi başlığı altında öğrenmiştiniz) ve bu veri setini çalışma klasörünüzün içine aşağıdaki kodu
kullanarak kaydediniz.

Not: auto isimli veri seti Amerika’da satılan 1978 model araçlarla ilgili bilgilerin yer aldığı bir veri setidir.

12
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. save "D:\Stata_workshop\auto.dta"

Stata menüsünden ise File > Save as > D > Stata_worksop > Dosya adını yazınız (auto) >
Kaydet adımlarını izleyerek veri setinizi kaydedebilirsiniz.

13



Selçuk GEMİCİOĞLU AÜSBF

İki farklı şekilde de veri setini kaydettikten sonra “D” sürücüsünde Stata_workshop klasörünün içinde
auto.dta isimli veri setinin yer aldığı aşağıdaki ekran görüntüsünde görülmektedir.
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Çoğu zaman elinizdeki veri seti üzerinde bazı değişiklikler yapmak ve bu değişiklikleri kayıtlı veri seti üzerine
yazdırmak isteyebilirsiniz. Böyle bir durumda aşağıdaki kodu komut penceresine yazarak bu işlemi gerçek-
leştirebilirisiniz.

. save "D:\Stata_workshop\auto.dta", replace

9 Veri Setine Ait Tanımlayıcı İstatistikler

Ekonometrik analize başlamadan önce, elinizdeki veri setini tanımanız gereklidir. Veri setinizin özelliklerini
anlamanıza yardımcı olacak birkaç komut vardır. Bu komutların bazıları benzer bilgiler sunar ve hangisini
kullanmayı tercih edeceğiniz size kalmıştır. Yine, ekonometrik analize başlamadan önce, her zaman tüm de-
ğişkenlerin frekanslarını, kategorik değişkenlerin nasıl kodlandığını, minimum, maksimum değerleri ve kayıp
gözlem sayısını kontrol etmelisiniz. Bu, veri setindeki uç noktaları ve olası hataları ortaya çıkarmanın en iyi
yoludur.

Veri setine ait tanımlayıcı istatistiklere codebook, list, tab, count, describe ve summarize komutlarını
kullanarak ulaşabilirsiniz. Bu komutların çoğunu Stata menüsünden Data > Describe Data > Açılan
Sekmelerden İstediğiniz Sekmeye Tıklayın takip ederek çalıştırabilirsiniz.

Komutları auto.dta veri setini üzerinde çalıştırarak aşağıdaki özet istatistiklere ulaşabilirsiniz.
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codebook komutu ile değişkenlerin özelliklerini özetleyebilirsiniz.

. codebook

list komutu ile gözlemleri listeleyebilirsiniz.

. list

Not: list komutunun devamına in 1/10 yazarsanız 1. satırdan 10. satıra kadar olan verileri listelersiniz.
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tab komutu ile seçili değişken ve değişkenler için frekans tabloları oluşturabilirsiniz.

. tab price

describe komutu size yine değişkenlerin özelliklerini verir.

. describe

17
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summarize komutu ile değişkenlerin maksimum, minumum, ortalama, standart sapma ve gözlem sayısı gibi
özelliklerine ulaşabilirsiniz.

Not: codebook komutu compact opsiyonu ile kullanılırsa summarize komutunun sonucuna benzer bir çıktı
elde edilir.

. summarize

10 Veri Seti ve Değişkenler ile Yapılan Temel İşlemler

Veri Seti ile Yapılan Temel İşlemler

Stata, veriyi numerik veya metin (string) olmak üzere iki şekilde saklar. Stata’nın metin olarak sakladığı
veriler belirli bilgiler vermek için kullanılır. Örneğin auto veri setinde araba markaları metin veriler olarak
tutulmaktadır. Veri düzenleyicisinde araba markalarının üzerine tıklandığında hiçbir sayısal değer almadığı
görülecektir. Bunun yanı sıra Stata’da metin verilerinin varsayılan rengi kırmızıdır.

Not: Metin verileri görünürde sayısal değerler alabilir fakat analizlerde kullanılamazlar. Çünkü Stata bu tür
verilere özünde sayısal değerler atamaz.

Aşağıda görüleceği üzere make değişkeni içinde 8. satırdaki hücrenin üzerine tıklandığında veri tarayıcısında
bu hücrenin sayısal bir değer almadığı Buick Regal adında bir metin olduğu görülmektedir.

18
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Stata’da eğer bir veri metin olarak saklanmıyorsa o veri mutlaka numerik olarak saklanmaktadır. auto veri
setinde make değişkeni dışındaki diğer tüm değişkenler numerik verilerden oluşmaktadır. Örneğin price
değişkeni içinde 4. satırdaki hücrenin üzerine tıkladığında veri tarayıcısında bu hücrenin sayısal değer aldığı
görülmektedir.

Herhangi bir veri setinde karşınıza çıkabilecek olası bir durum kayıp (missing) verilerin olmasıdır. Stata
kayıp verileri pozitif büyük değerler olarak algılar ve veri düzenleyicisinde kayıp veriler “.” olarak görünür.
Aşağıda görüleceği üzere auto veri setindeki rep78 değişkeni içinde kayıp veriler bulunmaktadır.
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Veri seti üzerinde yapılabilecek düzenlemelerin başında elinizdeki veri setinin istediğiniz bölümünü tutmak
veya atmak gelmektedir. Veri setinin belirlir bir bölümünü tutmak için keep, atmak içinse drop komutu
kullanılır. Aynı zamanda bu komutlar değişkenlerin veri setinde tutulması ya da atılması için de kullanılır.

Örneğin auto.dta veri setinde yalnızca fiyatı (price) 6000’e eşit ya da daha büyük olan araçları tutmak
istiyoruz. Başka bir deyişle fiyatı 6000’den daha düşük olan araçları veri setinden atmak istiyoruz. Bunu
yapmak için aşağıdaki Stata komutlarını kullanabilirsiniz.

. keep if price > = 6000 /* fiyatı 6000'ne eşit veya büyük olan araçları tutar */

. drop if price < 6000 /* fiyatı 6000'den küçük olan araçları atar */

Bu işlemlerin sonunda veri düzenleyicisini açtığınızda aşağıdaki ekran görüntüsü elde edilir.

20
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Görüleceği üzere bu komutun çalışması ile birlikte 51 gözlem silinmiştir. Yani 51 tane arabanın fiyatı 6000’den
daha küçük olduğu için veri setinde tutulamamış atılmıştır. Elinizdeki veri seti küçük gözlem sayısına sa-
hip olduğu için veri tarayıcısından arabaların fiyatlarını kontrol etmek oldukça kolaydır. Fakat elinizdeki
veri setindeki gözlem sayısı çok büyük ise veri tarayıcısından değişken değerlerini kontrol etmek oldukça
zorlaşacaktır. Bunun için keep if price >= 6000 komutu çalıştırıldıktan sonra (hatırlarsanız daha önce
öğrendiğiniz) summarize komutunu kullanarak tuttuğunuz veri setindeki en düşük araba fiyatını görebilir-
siniz.

Hem veri düzenleyicisinden hem de summarize komutundan sonra çıkan sonuç ekranında göreceğiniz üzere
fiyatı 6000’den düşük arabalar veri setinden atılmış olup en düşük araba fiyatı 6000’den yüksektir.
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Orjinal veri setine daha sonra ihtiyacınız olabileceği için keep ve drop komutlarını kullanarak yaptığınız
değişiklerden sonra yeni oluşan veri setinizi farklı bir isimle kaydetmeniz (hatırlarsanız daha önce veri setini
nasıl kaydedeceğinizi öğrenmiştiniz) gerekmektedir. Fakat preserve ve restore komutları veri seti üzerinde
yapılan değişikliklerden sonra yeni bir veri seti kaydetmenize gerek kalmaksızın size orjinal veri setinize
ulaşımı sağlamaktadır. preserve komutu orjinal veri setinizin anlık görüntüsünü alır ve restore komutu bu
orjinal veri setinize geri dönmenizi sağlar. Bunu aşağıdaki kodu kullanarak yapabilirsiniz.

. preserve

. keep if price > = 6000

. restore

Stata sonuç ekranında keep komutundan sonra 51 tane gözlemin silindiği görülmektedir. Fakat özellikler
penceresinde görüleceği üzere başlangıçta 74 olan gözlem sayımız bu komut dizini kullanılarak yeniden elde
edilmiştir.

Yukardaki örnekte olduğu gibi veri seti üzerinde düzenleme yaparken bir takım mantıksal operatörlerin
kullanımına gerek duyulmaktadır. Tablo 1’de bu operatörler ve açıklamaları yer almaktadır.

Tablo 1: Mantıksal Operatörler
Operatörler Açıklamalar

== eşit
! = eşit değil
> den büyük

>= den büyük ya da eşit
< den küçük

<= den küçük ya da eşit
& ve
| veya
∼ değil
! değil
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Değişkenler ile Yapılan Temel İşlemler

Analiz yaparken genellikle yeni değişkenler oluşturmaya ihtiyaç duyulmakta ve bunu yapmak için generate
komutu kullanılmaktadır.

auto.dta veri setini kullanarak generate komutu için aşağıda birkaç örnek verilmiştir.

. gen lnprice = ln(price) /* fiyat değişkeninin logaritması */

. gen pricesquare = price^2 /* fiyat değişkeninin karesi */

. gen yirmisekiz = 28 /* sabit bir değer alan değişken */

Not: gen komutu generate komutunun kısaltılmış halidir.

Yeni değişken oluşturmak için kullanılan bir başka komut ise egen komutudur. Bu komut minumum, maki-
sumum, ortalama ve toplam gibi özet istatistiklere bağlı olarak değişken oluşturmanıza izin verir.

Yine auto veri setini kullanarak yurtiçi ve yurtdışında üretilen araçların toplam, maksimum, minimum ve
ortalama fiyatlarını egen komutu ile aşağıdaki şekilde bulabilirsiniz.

. egen totalprice = sum(price), by(foreign) /* fiyat değişkeninin toplamı */

. egen minprice = min(price), by(foreign) /* fiyat değişkeninin minimumu */

. egen maxprice = max(price), by(foreign) /* fiyat değişkeninin maksimumu */

. egen avgprice = mean(price), by(foreign) /* fiyat değişkeninin ortalaması */

Aşağıda görüleceği üzere bu dört yeni değişken oluşturulmuştur.
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Oluşturduğunuz değişkenin ismini yanlış yazıdığınızı farkettiniz ve bunu düzeltmek istiyorsanız bunun için
rename komutunu kullanabilirsiniz.

. rename price fiyat

Aynı zamanda en yaygın kullanılan komutlar arasında recode ve replace komutları da yer almaktadır. Bu
iki komut var olan bir değişkenin değerlerinin yeniden kodlanmasını ya da değiştirilmesini sağlamaktadır. Bu
komutlar kullanılarak var olan değişkenin eski değerleri üzerine yeni değerleri yazdıralabilir veya değiştirilen
değerleri içeren yeni bir değişken oluşturulabilir.
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Örneğin lifeexp.dta veri setindeki bölge (region) değişkeni incelendiğinde bu değişkenin 1 = “Eur &
C.Asia”, 2 = “N.A” ve 3 = “S.A” değerlerinden yani üç farklı kategoriden oluştuğu görülmektedir.
Şimdi 2 = “N.A” ve 3 = “S.A” Kuzey ve Güney Amerika bölgelerinin tek bir bölge olacak şekilde
birleştirdiğiniz ve 1 = “Eur & C.Asia” Asya ve Avrupa bölgesinin aynı değeri aldığı region2 adlı yeni
bir değişken oluşturunuz. Daha sonra bu oluşturduğunuz yeni değişkende birleştirdiğiniz Kuzey ve Güney
Amerika bölgelerine America ismini vererek etiketlendiriniz.

Not: Değişkenlerin aldığı değerlerin neyi temsil ettiğini bilmek için genellikle bu değerler etiketlendirilmek-
tedir. Bölge değişkeninde olduğu gibi “1”, Avrupa ve Asya’yı “2”, Kuzey Amerika ve “3”, Güney
Amerika’yı temsil etmektedir. Bu bağlamda kodlama yapılırken bölgelerin isimleri değil aldığı değerler göz
önünde bulundurularak işlemler gerçekleştirilmektedir.

Yukarıda verilen örneği aşağıdaki komutları kullanarak yapabilirsiniz.

. recode region (1 =1) (2/3 =2), generate(region2)

. label define region2 1 "Eur & C.Asia" 2 "America"

. label values region2 region2

Görüleceği üzere Güney ve Kuzey Amerika tek bir bölge olacak şekilde region2 adlı yeni bir değişken içinde
oluşturulmuş ve America ismi ile etiketlendirilmiştir.

Aynı işlemi replace komutunu kullanarak aşağıdaki şekilde yapabilirsiniz.

. gen region2 = .

. replace region2 =1 if region ==1

. replace region2 =2 if region ==2 | region ==3

. label define region2 1 "Eur & C.Asia" 2 "America"

. label values region2 region2
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11 Grafik Çizme

Değişkenler arasında nasıl bir ilişki olduğunu görmek için tercih edilen yollardan biri grafik çizmektir. Sta-
ta’da bar, nokta, kutu, pasta ve dağılım grafikleri çizilebilmektedir. Stata çizilen grafikler üzerinde değişiklik
yapmak, not ve başlık eklemek açısından oldukça esnektir. Örneğin çizilen grafiğin x ve y ekseninin isimle-
ri, bu eksenlerdeki aralıklar ve grafik alanının rengi değiştirilebilir. Grafiğin sağ, sol, üst ve alt taraflarına
açıklama ve grafiğe not ve başlıklar eklenebilir. Burada yalnızca derste kullanacağımız dağılım grafiği anlatı-
lacaktır. auto veri setini kullanarak y ekseninde mpg, x ekseninde weight değişkeni olacak şekilde iki boyutlu
dağılım grafiği aşağıdaki üç farklı kod kullanılarak çizilebilir.

. scatter mpg weight

. twoway scatter mpg weight

. graph twoway scatter mpg weight
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Yukarıdaki grafikte görüleceği üzere aracın ağırlığı ve aldığı yol mesafesi arasında negatif yönlü ve doğrusal
olmayan bir ilişki vardır.

Sırası ile 1 ve 2 nolu sekmelere tıkladıktan sonra 3 nolu alandaki opsiyonları kullanarak grafik üzerinde
gerekli değişiklikleri yapabilirsiniz.
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Tüm değişikliklerin ardından grafiği aşağıdaki adımları izleyerek ya da kodu kullanarak kaydedebilirsiniz.

. graph save Graph "D:\Stata_workshop\Graph.gph"

Aşağıda görüleceği üzere çalışma klasörü içinde Graph adında bir grafik kaydedilmiştir.
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12 Do ve Log Dosyaları

Do Dosyası

do dosyası yazılan kodların komut penceresi kullanılmadan çalıştırıldığı ve bu kodların saklandığı bir dosya-
dır. Stata’da analiz yaparken do dosyasını kullanmanın en büyük avantajı yazdığınız kodlarda bir hata varsa
onu belirlemenizi ve kaldığınız yerden yazdığınız kodlara devam etmenizi sağlamasıdır. Komut penceresi kul-
lanıldığında yazdığınız tüm kodlar geçmiş işlemler penceresinde kayıtlı olsa bile Stata’yı kapattığınızda tüm
kodlar kaybolmaktadır. Bu yüzden Stata’da analiz yaparken do dosyası ile çalışmanız çok daha iyi olacaktır.

Stata menüsünden do dosyası 1 nolu sekmeye tıklanarak açılır. 2 nolu alan kodlarınızın yazıldığı alandır. 3
nolu sekme ise kodlarınızı çalıştırmak için tıklamanız gereken sekmedir. do dosyası CTRL + 9 kısa yolu
kullanılarak da açılabilmektedir. do dosyasında kodlarınızı çalıştırmanızın bir başka yolu ise CTRL + D
kısa yolunu kullanmaktır.
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do dosyasında yapılmasını istediğiniz işlemlerin kodlarını yazdıktan sonra kaydetmek için aşağıdaki adımları
takip edebilirsiniz.

Aşağıda görüleceği üzere çalışma klasörü içinde, lifeexp adlı do dosyası kaydedilmiştir.
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Log Dosyası
Log dosyası Stata’da yapılan tüm işlemlerin sonucunun kaydedildiği bir çıktı dosyasıdır. Log dosyasını çalışma
klasörüne kaydedebilir ve yaptığınız tüm işlemlerin sonucuna kolayca ulaşılabilirsiniz. Log dosyasında yapılan
işlemlerin kaydına başlanılması ve sonlandırılması için do dosyasında aşağıdaki kodu yazabilirsiniz.

. log using "D:/Stata_workshop/lifeexp_results.log", replace

. log close

Şimdiye kadar yazdığınız kodlarla do ve log dosyalarının kullanıldığı bir örnek oluşturunuz.

Aşağıda görüleceği üzere çalışma klasörü içinde, yapılan işlemlerin kaydedildiği bir log dosyası yer almaktadır.
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13 Yardım

Stata komutlarının hangi opsiyonlarla çalıştığı ve ne amaçla kullanıldığını akılda tutmak sizlere başlangıçta
zor gelebilir. Stata bu anlamda komutların nasıl ve ne amaçla kullanıldığını öğrenmeniz ya da hatırlamanız
için sizlere bir yardım imkanı sunmaktadır. Bunun yanı sıra unutulmamalıdır ki Google her zaman yardım
alacağınız iyi bir seçenektir! Stata’da yardım almak için help komutu kullanılmaktadır. Herhangi bir stata
komutu hakkında yardım almak almak için Stata menüsü ya da komut penceresi kullanılabilir.

. help summarize /* summarize komutunun nasıl çalıştığı ile ilgili bilgiler verir */

Görüleceği üzere summarize komutunun nasıl ve hangi opsiyonlarla kullanılacağının anlatıldığı bir pencere
karşınıza çıkmıştır. Opsiyonlar, komutun ardındaki “,” den sonra yazılan sözcüklerdir. Örneğin summa-
rize komutunun opsiyonlarından biri detail’dir. Bu opsiyon summarize komutunun daha detaylı bilgiler
vermesini sağlar. Bu opsiyonula beraber kod aşağıdaki gibi yazılır.

. summarize price, detail

summarize komutu normalde değişkenlerin yüzdelik dilimleri, varyansı, basıklığı ve çarpıklığı hakkında bilgi
vermemektedir. detail opsiyonu ile birlikte kullanıldığında ise bu ilave bilgileri de sağlamaktadır.

Not: sum, summarize komutunun kısaltılmış halidir.
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